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Chapter 531 

GEE Tests for Two 
Means in a Cluster-
Randomized Design 
Introduction 
This module calculates the power for testing the difference between two means obtained from a cluster-
randomized design. The mean come from continuous, correlated data that are analyzed using the GEE method. 
Such data occur in two design types: clustered and longitudinal. This procedure is specific to cluster-randomized 
designs. A companion procedure power analyzes data from a repeated measures design. 

GEE is different from mixed models in that it does not require the full specification of the joint distribution of the 
clustered measurements, as long as the marginal mean model is correctly specified. Estimation consistency is 
achieved even if the correlation matrix is incorrect. Also, the correlation matrix of the responses is specified 
directly, rather than using an intermediate, random effects model as is the case in mixed models. For clustered 
designs, GEE often uses a compound symmetric (CS) correlation structure.  

Time-averaged difference analysis is often used when the outcome varies with time. However, in this case, the 
observations are treated as if they were repeated measurements from a subject (cluster). Each cluster is 
randomized either in the treatment or the control group.  

Making these assumptions, the data may be analyzed using the GEE TAD methodology. This procedure performs 
a power analysis and sample size calculation for data obtained and analyzed in this manner. 

Missing Values 
This procedure allows you to specify a proportion of the subjects that are missing from each cluster.  
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Technical Details  

Theory and Notation 
Technical details are given in Ahn, Heo, and Zhang (2015), chapter 4, section 4.4.1, pages 110-116. 

Suppose we have K1 clusters in group 1 (treatment) and K2 clusters in group 2 (control) for a total of K clusters. 
The average cluster size (number of subjects per cluster) is M. The mean of yij is modeled by 

𝜇𝜇𝑖𝑖𝑖𝑖 = 𝛽𝛽1 + 𝛽𝛽2𝑟𝑟𝑖𝑖 

where 

𝑦𝑦𝑖𝑖𝑖𝑖 is the response of the jth subject from cluster i, with variance σ2 

𝜇𝜇𝑖𝑖𝑖𝑖 is expectation of 𝑦𝑦𝑖𝑖𝑖𝑖 

𝑟𝑟𝑖𝑖 is the cluster treatment indicator with 0 for control and 1 for treatment 

𝛽𝛽1 is the regression coefficient giving the intercept of the control group 

𝛽𝛽2 is the regression coefficient giving the TAD between the two groups 

 

In this procedure, the primary interest is on β2. 

This mean model is reparametrized as 

𝜇𝜇𝑖𝑖𝑖𝑖 = 𝑏𝑏1 + 𝑏𝑏2(𝑟𝑟𝑖𝑖 − 𝑟̅𝑟) 

where 

𝑏𝑏1 = 𝛽𝛽1 + 𝑟̅𝑟𝛽𝛽2 

𝑏𝑏2 = 𝛽𝛽2 

The vector of covariates is given by 𝑥𝑥𝑖𝑖𝑖𝑖 = (1, 𝑟𝑟𝑖𝑖 − 𝑟̅𝑟)′. 

GEE is used to estimate and test hypotheses about b with 𝒃𝒃�. 

Correlation Matrix Structure 
In a cluster-randomized design with K clusters, each containing M subjects, observations within a particular 
cluster are correlated. The pattern of those correlations is assumed to be compound symmetric, with a single 
correlation, ρ.  

A compound symmetry correlation model assumes that all correlations are equal, and all diagonal elements are 
one. That is 

�𝜌𝜌𝑗𝑗𝑗𝑗′� =

⎣
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⎡
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Sample Size Calculations 
The details of the calculation of sample size and power is given in Ahn, Heo, and Zhang (2015), Chapter 4, page 
113. These are summarized here.  

As explained above, GEE is used to estimate the regression coefficients b with 𝒃𝒃�. The significance of b4, the 
coefficient associated with the difference between the control and treatment slopes, is tested using a Wald statistic 
from which the following sample size formula is derived 

𝐾𝐾 =
𝜎𝜎2𝜂𝜂0 �𝑧𝑧1−𝛼𝛼ℎ

+ 𝑧𝑧1−𝛾𝛾�
2

𝛿𝛿2𝜇𝜇02𝜎𝜎𝑟𝑟2
 

where 

K = number of clusters 

M = average cluster size 

h = 1 (one-sided test) or 2 (two-sided test) 

γ = 1 – power 

α = significance level 

𝛿𝛿 = 𝛽𝛽2 = the mean difference 

𝜅𝜅 = proportion missing within a cluster 

𝜇𝜇0 = 𝑀𝑀(1 −  𝜅𝜅) 

𝜂𝜂0 = [𝑀𝑀2𝜌𝜌 + (1 − 𝜌𝜌)](1 −  𝜅𝜅) 

𝜎𝜎𝑟𝑟2 = 𝑟̅𝑟(1 − 𝑟̅𝑟) 

𝜌𝜌 = the intracluster correlation coefficient, ICC 

 

The above formula is easily rearranged to obtain a formula for power.  

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
This option specifies the parameter to be solved for. When you choose to solve for K1, the program searches for 
the lowest sample size that meets the alpha and power criterion you have specified. The Solve For parameter is 
displayed on the vertical axis of the plot. 
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Test 

Alternative Hypothesis 
This option specifies the alternative hypothesis. The null hypothesis is always H0: 𝛿𝛿 = 0 

Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the 
hypothesis test. Its accuracy is critical. 

Possible selections are: 

• One-Sided 
This option yields a one-tailed test. Use it for testing the alternative hypotheses H1: 𝛿𝛿 < 0 or H1: 𝛿𝛿 > 0. 

• Two-Sided 
This is the most common selection. Use it for testing the alternative hypotheses  H1: 𝛿𝛿 ≠ 0. 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of 
equal slopes when in fact the slopes are different. 

Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90 
(beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered. 

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal 
means when in fact the means are equal.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

Sample Size – Number of Clusters and Cluster Size 

K1 (Number of Group 1 Clusters) 
Enter a value for K1, the number of clusters assigned to group 1 (the treatment group). Each cluster is assumed to 
have M subjects. 

You may enter a single value such as 42, a list of values such as 10, 20, 30, or a range of values such as 10 to 100 
by 10. 

K2 (Number of Group 2 Clusters) 
Enter one or more values for the number of clusters in group 2, which we have designated as the control group. 
The sample size for this group is equal to the number of clusters times the number of subjects per cluster. 

This value must be a positive number. 

It can be a decimal (fractional) number such as '12.7'. The resulting value of N2 will be rounded to an integer. 
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Using Multiples of K1 
If you simply want a multiple of the value of group one, you would enter the multiple followed by "K1", with no 
blanks. If you want to use K1 directly, you do not have to enter the leading "1". For example, all of the following 
are valid entries: 

10K1 2K1 0.5K1 K1. 

You can use a list of values such as "10 20 30" or "K1 2K1 3K1". 

M (Average Cluster Size) 
Specify one or more values for M, the average number of subjects per cluster.  

At least one value must be entered. If multiple values are entered, a separate analysis is run for each value. 

The value must be greater than 1. A reasonable range is from 2 to 500. 

Some examples are 

3 

3 4 5 

3 to 10 by 1 

Effect Size  

δ (Mean Difference = μ1 - μ2) 
  

Enter a value (or range of values) for the cluster average difference (TAD) between the two treatments that you 
want to be able to detect. This value is in the same scale as σ. 

These values must be positive. 

You can enter a single value such as 10, a series of values such as 10 20 30 40 50, or 1 to 5 by 0.5. 

σ (Standard Deviation) 
  

Enter a value (or range of values) for the standard deviation of the response, Yij where i is the cluster and j is the 
subject. The analysis assumes that this standard deviation is constant across all subjects. 

These values must be positive. 

You can enter a single value such as 10 or a series of values such as 10 20 30 40 50 or 1 to 5 by 0.5. 

ρ (Intracluster Correlation, ICC) 
Enter one or more values for ρ, the intracluster correlation coefficient. 

At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value. 

Range 
0 < ρ < 1 (negative values are not used). A value near 0 indicates low correlation. A value near 1 indicates high 
correlation. 

Examples 
0.5 

0.5 0.6 0.7 

0 to 0.9 by 0.1 
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Missing Data Proportions Within Clusters 

Missing Input Type 
Specify the way in which you want to specify the pattern of missing values. 

Possible input choices are 

• Constant = 0 
The missing proportion is set to 0. That is, there are no missing values. 

• Constant 
All missing proportions are set to particular value. 

Missing Proportion 
Enter one or more values of the missing proportion that is to be used for all clusters. 

If multiple values are entered, a separate analysis is performed for each value. 

Range 
0 ≤ Missing Proportion < 1. 

Examples 
0.2 

0.1 0.2 0.4 

0 to 0.4 by 0.1 
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Example 1 – Determining Sample Size 
Researchers are planning a cluster-randomized study to compare a new drug with the standard drug for the 
treatment of a certain disease. The researchers want to investigate what happens when the cluster size is between 
10 and 40 patients. The outcome will be the change in heart rate.   

The study will be powered to detect a difference of 4. Similar studies have found a standard deviation between 8.0 
and 10.0. These studies had an ICC of 0.2. The two-sided test will be conducted at the 0.05 significance level and 
at 90% power. They are planning on dividing the subjects equally between the treatment and control groups. The 
researchers anticipate the proportion missing will be 0.10.  

How many clinics will be required for this study? 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load procedure window. You may then make the appropriate entries as listed below, or open Example 1 
by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ K1 (Number of Group 1 Clusters) 
Alternative Hypothesis ............................ Two-Sided 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
K2 (Number of Group 2 Clusters) ........... K1 
M (Average Cluster Size) ....................... 10 20 30 40 
δ (Mean Difference = μ1 - μ2) ................ 4 
σ (Standard Deviation) ........................... 8 9 10 
ρ (Intracluster Correlation, ICC) .............. 0.2 
Missing Input Type .................................. Constant 
Missing Proportion .................................. 0.1 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 
 
 Numeric Results ──────────────────────────────────────────────────────────────────── 
 Alternative Hypothesis:   Two-Sided 
 
  Number Clus Clus Clus  Clus Mean  Intra-   
  of Cnt Cnt Cnt Alloc Size Diff Std Clus   
  Subjects Total Grp 1 Grp 2 Ratio Ave μ1-μ2 Dev Corr  Miss 
 Power N K K1 K2 K1/K2 M δ σ ρ Alpha Prop 
 0.9088 540 54 27 27 1.00 10 4 8 0.2 0.050 0.10 
 0.9075 680 68 34 34 1.00 10 4 9 0.2 0.050 0.10 
 0.9010 820 82 41 41 1.00 10 4 10 0.2 0.050 0.10 
 0.9072 920 46 23 23 1.00 20 4 8 0.2 0.050 0.10 
 0.9061 1160 58 29 29 1.00 20 4 9 0.2 0.050 0.10 
 0.9076 1440 72 36 36 1.00 20 4 10 0.2 0.050 0.10 
 0.9106 1320 44 22 22 1.00 30 4 8 0.2 0.050 0.10 
 0.9022 1620 54 27 27 1.00 30 4 9 0.2 0.050 0.10 
 0.9076 2040 68 34 34 1.00 30 4 10 0.2 0.050 0.10 
 0.9061 1680 42 21 21 1.00 40 4 8 0.2 0.050 0.10 
 0.9104 2160 54 27 27 1.00 40 4 9 0.2 0.050 0.10 
 0.9076 2640 66 33 33 1.00 40 4 10 0.2 0.050 0.10 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. 
N is the total number of subjects in the study. 
K is the total number of clusters. K = K1 + K2. 
K1 is the number of clusters in group 1, the treatment group. 
K2 is the number of clusters in group 2, the control group. 
K1/K2 is the allocation ratio. The smallest sample size occurs when it is 1.0. 
M is the average cluster size. That is, it is the number of subjects per cluster. 
δ is the time-averaged difference (TAD) at which the power is calculated. It is in the same scale as σ.  
σ is the standard deviation of a response.  
ρ is the intracluster correlation coefficient or ICC. It is the correlation between any two subjects within a cluster. 
Alpha is the significance level of the test. It is probability of rejecting the null hypothesis when it is true. 
Miss Prop is the missing proportion. This is the proportion of subjects that are not expected to complete the study. 
 
 
Summary Statements ───────────────────────────────────────────────────────── 
A sample of 54 clusters, each with a cluster size of 27, achieves a power of 0.9088 when using a two-sided Wald 
test from a GEE analysis to test whether the treatment group differs from the control group by more than 4 at a 
significance level of 0.050. The total number of subjects in the study is 540. The treatment group contains 27 
clusters and the control group contains 27 clusters. The residual standard deviation is anticipated to be 8. The 
intracluster correlation coefficient (ICC) is 0.2. The anticipated proportion missing is 0.10. 

 

This report gives the necessary cluster count for each value of the other parameters. 

 
 

     
 

These charts show the relationship among the parameters varied.  
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Example 2 – Finding the Power 
Continuing with Example 1, the researchers want to determine the power corresponding to K1 values ranging 
from 20 to 40 and a standard deviation of 9. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alternative Hypothesis ............................ Two-Sided 
Alpha ....................................................... 0.05 
K1 (Number of Group 1 Clusters) ........... 20 30 40 
K2 (Number of Group 2 Clusters) ........... K1 
M (Average Cluster Size) ....................... 10 20 30 40 
δ (Mean Difference = μ1 - μ2) ................ 4 
σ (Standard Deviation) ........................... 9 
ρ (Intracluster Correlation, ICC) .............. 0.2 
Missing Input Type .................................. Constant 
Missing Proportion .................................. 0.1 

Output 
Click the Calculate button to perform the calculations and generate the following output. 
 
 Numeric Results ──────────────────────────────────────────────────────────────────── 
 Alternative Hypothesis:   Two-Sided 
  

 Number Clus Clus Clus  Clus Mean  Intra-   
 of Cnt Cnt Cnt Alloc Size Diff Std Clus   
 Subjects Total Grp 1 Grp 2 Ratio Ave μ1-μ2 Dev Corr  Miss 
Power N K K1 K2 K1/K2 M δ σ ρ Alpha Prop 
0.7122 400 40 20 20 1.00 10 4 9 0.2 0.050 0.10 
0.7769 800 40 20 20 1.00 20 4 9 0.2 0.050 0.10 
0.7997 1200 40 20 20 1.00 30 4 9 0.2 0.050 0.10 
0.8113 1600 40 20 20 1.00 40 4 9 0.2 0.050 0.10 
0.8699 600 60 30 30 1.00 10 4 9 0.2 0.050 0.10 
0.9152 1200 60 30 30 1.00 20 4 9 0.2 0.050 0.10 
0.9292 1800 60 30 30 1.00 30 4 9 0.2 0.050 0.10 
0.9359 2400 60 30 30 1.00 40 4 9 0.2 0.050 0.10 
0.9456 800 80 40 40 1.00 10 4 9 0.2 0.050 0.10 
0.9706 1600 80 40 40 1.00 20 4 9 0.2 0.050 0.10 
0.9773 2400 80 40 40 1.00 30 4 9 0.2 0.050 0.10 
0.9803 3200 80 40 40 1.00 40 4 9 0.2 0.050 0.10 
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The report and plot show the power for each scenario. 

  

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
GEE Tests for Two Means in a Cluster-Randomized Design 

531-11 
 © NCSS, LLC. All Rights Reserved. 

Example 3 – Validation using Ahn, Heo, and Zhang (2015) 
Ahn, Heo, and Zhang (2015) do not present any numerical examples for this procedure. However, on page 115 
they give a simplified formula for the compound symmetry case. We will calculate a result by hand using this 
formula and then calculate with the program to validate this procedure.  
The simplified sample size formula is 

𝐾𝐾 =
4𝜎𝜎2[1 + (𝑀𝑀 − 1)𝜌𝜌] �𝑧𝑧1−𝛼𝛼ℎ

+ 𝑧𝑧1−𝛾𝛾�
2

𝛿𝛿2𝑀𝑀
 

Using M = 5, σ = 3, ρ = 0.5, δ = 1.5, α = 0.05, and power = 0.9, we obtain 

𝐾𝐾 = ceiling�
4(32)[1 + (5 − 1)0.5](1.96 + 1.28)2

1.52(5) � 

=  ceiling(100.78) 
=  101 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the procedure window. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ K1 (Number of Group 1 Clusters) 
Alternative Hypothesis ............................ Two-Sided 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
K2 (Number of Group 2 Clusters) ........... K1 
M (Average Cluster Size) ....................... 5 
δ (Mean Difference = μ1 - μ2) ................ 1.5 
σ (Standard Deviation) ........................... 3 
ρ (Intracluster Correlation, ICC) .............. 0.5 
Missing Input Type .................................. Constant = 0 

Output 
Click the Calculate button to perform the calculations and generate the following output. 
 
 Numeric Results ──────────────────────────────────────────────────────────────────── 
 Alternative Hypothesis:   Two-Sided 
 
  
  Number Clus Clus Clus  Clus Mean  Intra-   
  of Cnt Cnt Cnt Alloc Size Diff Std Clus   
  Subjects Total Grp 1 Grp 2 Ratio Ave μ1-μ2 Dev Corr  Miss 
 Power N K K1 K2 K1/K2 M δ σ ρ Alpha Prop 
 0.9031 510 102 51 51 1.00 5 1.5 3 0.5 0.050 0.00 
  
The number of clusters of 102 matches the above calculations very closely. Actually, the hand calculations of 101 
clusters did not take into account that we wanted K1 = K2, which require an even number. PASS gave us the 
desired even number by increasing the number of clusters from 101 to 102. 
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